Getting Started with PIC18F Programming in C18 using Laboratory
Projects

Lesson 1 - Creating a C18 Project with
MPLAB

Objectives
e To build a C18 project
e |dentify the location of C18 program files

Preparation:
Microchip’s MPLAB IDE and MPLAB C18 compiler are required for this and all the lessons. It is
assumed that these have already been installed as instructed in an earlier lesson.

Required Resources:
Computer with MPLAB and C18
PIC18F4520 datasheet

Procedure
In this lab a project will be created that is compiled under C18. The program is essentially an
empty program shell, but it illustrates the procedure for creating a new C18 project and
compiling it under MPLAB.

Note:
It is highly recommended that each project be saved under a separate directory. This will
ensure that all project related files are accessible from the same folder.

Create a new folder on computer drive and name it lesson1
Open a MPLAB session
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3. Click on the Project Menu and select Project Wizard

“ MPLAB IDE v8.40
File Edit ‘iew | Project Debugger Programmer Tools Co

ard. .. | -:Il%

[ew, ..

Open. ..

Close k
Set Active Project b

Quickbuild {mo, asm File)

Package in .2ip erzion [
leam

Build Configuration k
Build Cptions. .. k

Save Projeck

Save Projech 4s, ..

Add Files bo Project, .

Add Mew File to Projeck, .
Remave File From Project L3

Seleck Language Taolsuite, ..
Set Language Tool Locations. ..
Wersion Contral...
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Project Wizard dialog box opens.
[rroectwizard x
. Welcome!

Thiz wizard helps you create or configure a new MPLAR IDE
project.

Tao continue, click Wext,

< Back I Mext » I Cancel Help
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Device Selection

Click on the Next button and the dialog box for the first step appears.

x
Step One: Eﬁ‘
Select a device /'
i

< Back I M et > I Cancel Help
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In the Device drop down list box a processor is identified. If list box does not show the correct device,
click on the down arrow to select the device of interest. It can be done in one of the two ways:

e Scrolling through the devices list
e Entering the correct name of the device in the list box.

Here the device of interest is PIC18F4520, so it is selected from the drop down list box (scrolling up or
down as needed).

x|
Step One: Eﬁ
Select a device /
%t

FICT2F1320 =]
EEEZET - |

FIC 6 4523
PICBF 4525
PICBF 4539
PIC BF4550
PIC1GF4E53
PIC1GF 456
PICBF4550
PICBF 4505
FIC18F45I10
PIC1GF45I11 Lo Fielz
PIC1GF 45150

Having selected the correct device, click the Next button to advance to the next step.
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Language Tool Suite Selection

Step two of the dialog box opens, displaying the current language tool suite in effect.

Project Wizard x|

Step Two:

Select al toalsLit Eﬁ
elect a language toolsuite f
]

Active Toaolsuite: @PﬁSM T oolsuite E

— Toolzuite Contents

M P&SH Aszembler [mpazmwin,exe] w5, 34
MPLINE Object Linker [mplink. exe] v4.34
FMPLIB Librarian [mplib.exe]

— Lacation

C:%Program FileshMicrochiptPASk Suitehhd Phzmisin exe Browse. .. |

[ Store tool locations in project

Helpl My Suite [sn't Listed! | [ Show all installed taolsuites

< Back I et = I Cancel Help
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The current toolsuite (ActiveToolsuite) is MPASM Toolsuite, which is not the desired Toolsuite.

Again using dropdown list box select C18 Toolsuite

Project Wizard

Step Twao:
Select a language toolsuite

]
EE:/%}

Active Toolsuite: Microchip MPASH Toolzuite

[

_ ; B Krudsen Data CCR-
Tu:uu:ulswtel:nntents B Krudenn Data COAE

GIREFIGIEEEIN B yte: Craft Assembler & C Compiler

MPLINE Objech

MPLIB Libraran|aR PICT 2

|&F Systems Midrange

dicrochip C13 Toaolsuite

~ Location Microchip MPASM Toolsuite

CCS C Compiler for PIC10412/1 4416/ 8424/ dsPIC30/d:PIC33

IE: WProgram Filez\MicrochipitPAS Suikeh b Phemiedin exe

[ Store tool locations in project

Browse. .. |

Helpl My Suite [sn't Listed! | [ Show all installed taolsuites

< Back I et = I

Cancel

Help
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Toolsuite Contents

The active Toolsuite is changed to C18.

Project Wizard x|

Step Two:

r W
Select a language toolzuite Ef@

Active Tookute: | Micrachip C18 Toolsuite =]

L

— Toolzuite Conk

MPASK Azsembler [mpasmwin.es
FPLIME. Object Linker [mplink. exe] w4,
MPLAR C18 C Compiler [moc 8. exe] w334

LI T ] ISP RPN | N, |

— Locatian

C:AMECCT BhmpazmMPAS WIN . ex Browse. .. |

[ Store tool locations in project

Help! My Suite lsn't Listed! | [T Show all installed toolsuites

¢ Back I M et = I Caricel Help

The Toolsuite has 4 components:

e Assembler

e Object Linker
e C Compiler

e Llibrarian

The files associated with these components are identified in the location box. As the assembler file has
been highlighted in the Toolsuite Contents, its location is being identified in the Location box as:

C\MCC18\mpasm\MPASMWIN.exe.
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If the Object Linker file is highlighted, its location is identified in the Location box.

Project Wizard x|
Step Two: %
Select a language toolzuite fﬁ'}

Active Toolzuite: Microchip C18 Toolzuite j

— Toolzuite Contents

MPASH dezembler [mpazmmin.exe] «5.34 -
MPLINE Object Linker [mplink. exe] «4.34 [

MPLAR I_:'I a E E-:ump_iler [moc] 3 exe] w334 j
— Location

C:ACET 8M\binmplink. e

[ Store tool locations in project

Help! My Suite lsn't Listed! | [ Show all installed toolsuites

< Back I M et = I Canicel Help

It is a good idea to become familiar with the location of each of these four files (components) of MPLAB

C18 Toolsuite.

To Do: Highlight each component and view the file location.
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Manually Locating Toolsuite Components

Sometimes, the location box may indicate a wrong location, or it may be empty. This could be the result
of either the previous project using a different Toolsuite or because of the action of another user of the
computer. In this case, the components can manually be located. The following screen shot shows a
situation, where this action may be necessary.

[ ||
Project Wizard x|

Step Twao:

Select al toolzuit Eﬁ
elect a language toolsuite f
]

Active Tookuite: | Micrackip C18 Taolsuite =|

T oolsuite Content |

MPASH Azzembler [mpasmwin.exe]
' ¥ MPLINE Object Linker [mplink. exe)
MPLAR C18 C Compiler [moc1 8. exe] w334 ;I

L LI T T PRI PR (AP Y P, |

Lacation

I Browse. .. |

[ Stare tool locations in project

Help! My Suite [sn't Listed! | [ Show all installed taolsuites

< Back I et = I Cancel Help

Here first two components have not been located and MPLAB has places an ‘X’ besides each one of the
two.

In this case the location, where these two components are located has to be identified correctly.

To locate the first highlighted components (MPASM) click the Browse button.
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A dialog box opens.

Select Language-Tool Executable ed A

Lok jr; | e R Najt j @ ? . v
Arduing |3 Jennic I3 Microchip
Cadence [CILPCHpresso (M ws
Documents and Settings CMcc1s [Shnp

Eclipse_C | Micro Framework, [Cyorcan
Eclipse_lava |=iMicrochip Application Libraries  [Z5)Program F
Epsan [CMicrochip Solutions [5G
L I i
File name: I

Open I

Files of type: IE:-:ecutaI:nle Files [*.ewe)

- Cancel
B | =l |

Browse to the folder where MCC18 has been installed. MPASMWIN is contained in mpasm sub-folder of

MCC18.

select Language-Tool Executable 7| x|

QT @

Look in: | &2 i
bin I)libpopt:
doc S
exarnple ﬁﬁUNWISE
h
lib

File name: — [MPASMwWIN

| Open I

Files of type: | Executable Files [*.exe)

j Cancel |

&
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Open mpasm folder:

Select Language-Tool Executable d A
Look it Ila mpasm j €] T 2 e

File name: | Open I
Files of type: | Executable Files [*.exe] =l Cancel |

4

MPASMWIN file is located in this folder. Highlight it

select Language-Tool Executable 7| x|
Look in: | () mpasm B e N N

File narme: |MPﬂ5MW|N | Open |

Files of type: | Executable Files [ eve) =l Cancel |

&

The file name is shown in the File name: box now click the Open button.
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The Step two of Project Wizard dialog box appears again. This time the MPASMWIN has been
identified on the computer and the ‘X’ mark has been removed from the Assembler component.

Project Wizard

Step Twao:

x|

Select al toolsLit Eﬁ
elect a language toolsuite f
s

1

Active Toolsuite: Microchip 018 Toolzuite j

— T oolzuite Content

M PASH Aszembler [mpazmwin.exe] w3
W, METHS L e L
MPLAR I_:'I 3 E Eu:ump_iler [moc] 3 exe) v3.34 ;I
— Location

—
qc:wcm BmpasmiMPASMWIN.axe 2 Browse... |

[ Store tool locations in project

Help! by Suite lsn't Lizted! | [ Show all installed toolsuites

< Back | MHext = | Cancel | Help
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Similarly, using the Browse button, locate the next missing component. It is located in bin sub-

folder of MCC18.

Select Language-Tool Executable
Look in: | &2 YL Slo

2lxl
- ,

IClibpopt
[Cympasm
Dhsre

S5 unwise

File name: I

Files of type: | Executable Files [.exe) | Cancel |
S

Open I

Open the bin sub-folder and identify the mplink.exe file. It is helpful to drag the Select Language

dialog box to the side of the Project wizard dialog box to see the required file name (as shown

below)
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v '
Project Wizard x|

Step Two: rh‘
Select a lahguage toolsuite

Select Language-Tool Executable

Active Toolsuite: IMicn:u:hip C18 Toolsuite Lak in: Ili kit j o 11- i P

r— Toolzuite Contents

MP&SM Assembler [mpasmwinexe] w534 LR ' Blmpzcad
MPLINE Object Linker [mplink. sxe] _mplirk Fmpzhex
MPLAR C18 C Compiler [mcc8.exe] 3,34 cppléa Emplib

mecls @ Date Created: 10/20/2009 11:24 PM
- Locatian mecl §-extende Size: 957 KB

I mee 1 3-traditional

[ Stare tool losations in project

Helpl My Suite lsn't Listed! | File name: — [mplink ﬂl
Files of type: IEMecutahIe Files [*.exg) j Cancel |
A

< Back | MHest » | Cancel | Help

Notes:

e Itis important that the Toolsuite location be correctly specified for C18 Toolsuite

e The location of each of the 4 files needed by C18 Toolsuite needs to be individually verified

e All these files need to come from the same MCC18 folder.

e Multiple versions of these files with same name(s) are sometimes located in different folders.
These are not interchangeable and only the files from MCC18 folder can be used.

o The location of MCC18 folder varies from computer to computer and depends upon the
installation. The following two paths are commonly encountered:
o C:\MCC18
o C:\Program Files\Microchip\MCC18
e [tis imperative that the above should be (quickly) checked, every time a new project is built.
e Once the Toolsuite location has been correctly identified, subsequent project builds should
automatically identify the correct location of these components, unless the same computer, at
times, is being used with different Toolsuite.
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After all components have been correctly identified, the Step two dialog box will look like as
follows(repeated):

Project Wizard x|

Step Two:

Select al toolsLit %
elect a language toolsuite /’
]

Active Toaolsuite; IMiu:ru:u:hip C18 Toalzuite j
— Toolzuite Conbas

MPASH A npas
MPLIME. I:I|:||E|:t Llnker [mplink.
MPLAR C18 E Cormpiler [m|:|:1 3. exe] v3 34

I O ) ISP RPN 1) I, |

— Location

C:AMECT BvmpasmMPAS WM ex Browse. .. |

[ Store tool locations in project

Help! My Suite lzn't Listed! | [ Show all installed toolsuites

< Back I MHext > I Cancel Help

Click on the next button to go to Step Three of the dialog box.
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The Step Three dialog box appears.

Project Wizard x|

Step Three: Eﬁ‘
Create a new project, or recanfigure the active project? fﬁ'}

) Browse. . |

—1" Eeconfigure Sctive Froject
= Miake changes without saving

{° Save changes o existing praject file

I Browse... |

|,r- Save changes to another praject file

< Back I et = I Cancel | Help |

The project location shows an empty box. Clcik on the Browse button and point it to the folder Lesson 1
that was created at the start.
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The folder opens

Save in; Il.f,\ Lesson j €] A

|5y 5creenshots

Save az hype: IMF'L.E‘-.B IDE Project Files [*.mcp] vI Cancel |

Jump to: | D:AS BN CollegsADIGLAM 4EX\Data Acquisi 7 |

Enter the project name ‘lesson_1" and click Save button.

v

Do not add any extension. An extension of ‘mcp’ will automatically be added to the project name.

Save in: Il.ﬂ Lessonl Qe E-

|5y 5creenshots

File name: < ilessnn_'l ) | Save I
Save az type: IMF'L.-'l'-.E! IDE Project Files [*.mcp) j Cancel |

Jump to: | D:AS BN CollegsADIGLAM 4EX\Data Acquisi 7 |

v
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The Project Wizard dialog box returns, displaying the name of newly created project.

I Project Wizard x|

Step Three: E
Create a nev project, or reconfigure the active project? /ﬂ

— (¥ Create Mew Project File

£ ID:HE'IE Programmingtlessonllessan 1 Browsze. .. I

— | Reconfigure Active Fraject

" Make changes without saving

" Save changes to existing project file

€| Save changes to another, project file

Browse,.. |

¢ Back Mext = | Cancel | Help |
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Step Four of Project Wizard is reached. This allows addition of any existing files to the project folder.
Since, there are no existing files, simply click on the Next button to advance to the next step.

Project Wizard x|

Step Four:

&
Add exizting files to your project /{:::'}

- 9e7chida314298734 a |
-] adadfada3775012763M Add >> |
-] Books

EIl:I 18 Pragramming J Femove |
- B4 Lesson

: & Screenshats
l:l CD Backup

-] d93404cE26091 00cds
&[] Downloads

-] Drivers

&[] dsPicDem?

l:l E agle Projects ¥
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The project summary page appears, listing the following items:

o The device (PIC18F4520 in this case)
e The Toolsuite (Microchip C18)
e The project folder path and the project file name (lesson_1.mcp)

Project YWizard x|

. Summary

Click "Finizh' to createsconfigure the project with these
paraneters.

— Project Parameters
Dewvice:  PIC18F4520

Toolsute:  Microchip C18 Toolsuite

File: D:%C18 ProgrammingiLeszon \eszon_T.mop

&, new workspace will be created, and the new project added
ta that workspace.

< Back I Firizh I Cancel Help

Verify that the summary page provides the correct information, else go back and make necessary
corrections. Once satisfied, click the Finish button.
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The MPLAB screen shows the project screen.

&% '=ason_1 - MPLAB IDE vi.30

Ce=tiogger  Programmer  Tools  Configure  Window  Help

CmE | EHABER? by TS HBa® SHaB

s e
= 1 lesson_L.mep Build | version Eu:untru:ull Find in Filesl

| Source Files |

i..[ T Header Files
...... |:| Object Files
...... I:I Library Files
...... I:I Linker Script
...... I:I Other Files

[ Files @g Symbals

e The project name is shown in top status bar (lesson_1)

e A project panel appears showing the names of various folders that may be used with the project

An output panel that will display the output of C18 compiler, during the build process.

[ ]
Source File

Every project has to have a minimum of one source file. Currently, the Source Files folder in project
panel (accessible through View—=>Project, if closed) is empty, as it contains no source file.

The next step is to add a source file.
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Addition of a Source file

Highlight the Source Files folder in project panel.

w lesson_1 - MPLAB IDE v8.40 - lesson
File Edit | Views Project Debugger Progr

| D@ | & mE | &4
B lesson_L.mew S[al P

1

----- [ Object Files
----- 3 Library Files
----- [ Linker Scripk
----- [ Other Files

(] Files 1+ Symbols

From File menu select Add New File to Project.

:{;qlessun_l - MPLAB IDE v8.40 - lesson_1.mcw

File Edit %ew Projeck Debugger Programmer Tools  Configure  Window  Help
Chrl+M

Add Mew File to Project. ..
Open., ..

Cerl+O

Hose i ild |‘-.-"ersiun Eantrull Fird i Filesl
Sayve hrl+S

SaVE B5

Sayve Al ZhelShift4S
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A dialog box opens.

Browse it to the project folder (lesson_1).

,“ lesson_1 - MPLAE IDE ¥8.40 - lesson_1.mcw

File Edit ‘Wiew Project Debugger  Programmer  Tools  Configure  SWindow  Help

= [ lesson_1.mcp* j Q Ij > [
---- (1 Source Files Screenshots
..... [ Header Files leszon 1
..... [ obiject Files lesson_1
..... g ::ibLZWSF"?st lesson_1.mcs
..... inker Scrip
..... (L3 other Files

(] Files | #2 Symbols

File name: | | Save I
Cancel |

4

Sawve az type: I.-'l'-.II Files [*.7]

=l
=l

Jump to; I [:MC18 ProgrammingLessonl®

It can be seen that it contains 3 files related to the project that MPLAB has automatically created.
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In the File name box enter the name of the source file. It will be named as first.c (for a lack of a better
name).

Note:
It is important that the ‘.c’ extension be added. This practice will save headaches later on.

,“ lesson_1 - MPLAB IDE ¥8.40 - lesson_1.mcw
File Edit ‘Wiew Projeck Debugger  Programmer  Tools  Configure Window  Help

=101.x] 21|
= L1 lesson_1.mcp* Save i IE} Lezsont j & -? 2 [

..... [ Source Files
..... (L] Header Files
..... [ oObiject Files
..... [ Library Files
..... (23 Linker Script
..... [ other Files

[ ] Files o+ Symbols

File name: | Ifirst.c ) Save I
Cancel |

4

Save as type: I.-'i‘-.II Files [*.%)

[
=

Jurnp b I D:AC18 ProgramminghLessont®,

Click the Save button.
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The source file is created and added to the project as indicated in the project panel.

An editor panel (Editor panel) also opens with name of the project and source file indicated in the status
bar. This is used to enter the source code (C18 code) to the project

% lesson_1 - MPLAE IDE ¥8.40

File Edit Miew Project Debugger Programmer Tools  Configure  Window  Help

(T i — _ioix
- |:| lesson_1.mecp* Build |"Jersiu:un Eu:untru:ull Fird in Filesl I
|__—_||:| Source Files o d

- Il D:.C18 ProgrammingLessonl ' first.c 1ol =
..... [ Header Files
..... (L1 ohbiect Files
..... [ Library Files
..... [ Linker Script
..... [ other Files

[ Files | “# Symbols (] _’F

{Editor panel)
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Adding (Source) Code to Source File

e Expand the editor panel.

e Type the following code in the editor panel. (Type as is shown)

/************************************
Name: S Gupta
Date: April 25, 2010
first.c
Starting with C18 Programming

************************************/

#include <pl8f2420.h>

void main (void)

{

}
//

Once, finished with entering the code, click on the Floppy icon and save the file.

% lesson_1 - MPLAB IDE v8.40

File Edit Yiew Project Debugger Programmer Tools Configure  Window  Help

Il lesson_ 5ave File |2 x| Ml D:'.C18 Programming’,Lessonl’ first.c* - O] x|
[ssssss———ssssssss—s==—====—===================—=————————————————
_."II************************************ |—
= [ lesson_1.mcp ||
-1 Source Files Name: & Gupta
L First 0 Date: &pril 25, Z010
_____ (2 Header Files File: first.o
_____ [ obiect Files Ftarting with Cl13 Programming

************************************f‘l

----- 3 Library Files

----- (23 Linker Seript .
..... [ Other Files #include <plBE4320.h-

void main (woid)

{

} =
[ Files #+ Symbals I - | | LI—I

Building the Project
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Although, it is an empty project, it can still be built.

Click on the Build All icon and build the project.

Observe the output Window, there should be no errors, otherwise check the source code and build
again.

# lesson_1 - MPLAB IDE v8.40
File Edit Yiew Project Debugger Programmer Tools Configure  Window  Help

| DEE ' me | SH2I8 2 o "o bed (uas
=101 x| Il D:'.C18 ProgrammingLessonl ' first.c* / Euaild Al x|
EDI l -"Ill*********************************7* [—
esson_1.mcp -
=3 Source Files Name: & Gupta .
2 Frst.c Date: april 25, zoig (Build Alllcon)
..... D Header Files FilE: first.c
_____ [ obiect Files Starting with Cl18 Programming
DLI:' Fl **************'.l-****'.l-****'.l-***********EIl
----- ibrary Files
----- [0 Linker Scripk _—
; #Hinclude <pl8£4520. h>
----- (23 other Files P
wvoid main (woid)
i

[ Files ﬁ; Symbals I - | | LILI

© S Gupta www.mcjournal.com Page 28



Getting Started with PIC18F Programming in C18 using Laboratory
Projects

On a successful build the output panel indicates a success “BUILD SUCCEEDED”

% lesson_1 - MPLAB IDE v8.40

File Edit View Project Debugger Programmer Tools Configure  Window Help
| DM ™mE EBSOR 2 [Debwg Mo EE @@ S e
Mmowest =10l x|

Build | Yersion Control I Find in Files I

Clean: Deleting intermediary and autput files. Al
Clean: Deleted file "DACTE ProgrammingiLessonTifirst.o”,

Clean: Deleted file "DAC18 ProgrammingiLessonTiesson_1.cof".

Clean: Deleted file "DAC18 ProgrammingiLessonilessan_1.hex".

Clean: Daone.

Executing: "CAMACCT B\ainymcc] 8. exe” -p=18F4520 "first.c" Ho="first.0" -D__DEBUG -Ou--0t--Ob- -0p--0r- -0d--Opa-
Executing: "CAWCCT B\hinymplink. exe" /o18F4520 A"CAMCCTSik" "first.o" Ju_CRUNTIME fu_DEBUG fz_ MPLAB_BUILLC
MPLINK 4.34, Linker

Copyright {(c) 2009 Microchip Technology Inc.
Errors 0

MPZHEX 4.34, COFF to HEX File Conwverter

Copyright {(c) 2009 Microchip Technology Inc.
Errors .0

Loaded DAC18 ProgrammingiLessontiesson_1.cof.

Debug build of project "DACTS ProgrammingiLessonlyesson_1.mcp' succeeded.
Language tool versions: MPASMWIN exe +5.34, mplink.exe w434, moclexe w3 34
Freprocessor symbol "__DEBUG' is defined.

Sun Apr2517:57:47 2010

BUILD SUCCEEDED

-
a | >

Congratulations! The project has been successfully built.
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Closing the Project

The project should always be properly closed.

Click on Project =>Close to properly close the project (saving all required MPLAB files)

a lesson_1 - MPLAB IDE ¥8.40

File Edit Wiew | Project Debugger Programmer  Tools  Configure  Window  Help
Project Wizard. . i
D@ E | " Debug ~Ii ZHB@® | S wam

I s son_L e 1ol

Y18 Programmingilessonlilesson_1.mcp
g Zupta ——— —
April £5, 2010

N uickbuild i s file)

..... D Hear ) i first.c
..... [ obje Package in .zip ng with C18 Programming

Lib Clean Frddddbd bt bbb bbb d b a k)
..... I ora

& Locate Headers -
..... Linke Export Makefile

rpl8£45%20. hi
""" LI othe gy a ctisFta | T
Make F10 .
Build Configuration k (void,
Build Options. .. r

__ Save Project
[ Files #: Save Project As...
E— Add Files to Project...
Add Mew File to Project. ..
Remove File From Project

Select Language Toolsuike. ..
Set Language Tool Locations. ..
Yersion Conkral,.,
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Getting Started with PIC18F Programming in C18 using Laboratory
Projects

MPLAB window with no projects opened is displayed.

s MPLAE IDE v8.40

File Edit Wiew Project Debugger Programmer  Tools  Configure  Window  Help

| DEH|smE [ SHhw AR P ] o s @ Ewd

Click on File=> Exit to close MPLAB session.

& MPLAE IDE v8.40

File Edit “iew Project Debugger Programmer Tools  Configure  Window  Help

Mew Chrl+R a7 J I__,Iﬁgﬁﬁ =Y i,

Gdd Mew File to Froject.. .
CpEM. .. Chrl+0
Close ZhHH-E

Save Zhrl+5
Save As.,,,
Save &l (0 o o e [ e

Cpen Workspace, .,
Save Warkspace
Save Wiorkspace As. ..
Clase Workspace

Irnpork. ..
Export...

Primt.. Zh P

Recent Files
Recent Waorkspaces

This terminates the MPLAB session.

This concludes Lab1. *¥**
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